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Introduction
The Kodak Digital Science� Calibration Utility for MICROSOFT
WINDOWS and MACINTOSH (Calibration Utility) allows you to bring 
your printing system to the best possible color response.

Kodak thermal dye diffusion printing systems are composed of printers
and printer media (thermal ribbon and paper or transparency material).
Normal variability in the manufacturing processes of printers and media
may cause slight variations in light gray (low density) areas of prints. 
The human visual system is sensitive to color changes in low density
areas on prints and you may occasionally want to adjust your printer
output to match viewing conditions.

The Calibration Utility allows you to select export and import modules,
open and save calibration tables, enter measurement information from 
a test print, and calculate a new calibration table. The calibration test
prints are key to the Calibration Utility. The new calibration table allows
you to adjust the levels of cyan, magenta, and yellow dye to create a
neutral gray with the correct density.

What’s in this Guide
This guide consists of the following chapters:

Introduction —describes the calibration prints and the recommended
process for using the Calibration Utility.

Chapter 1: Calibration Utility for MICROSOFT WINDOWS —describes
how to use the Calibration Utility on WINDOWS systems.

Chapter 2: Calibration Utility for MACINTOSH —describes how to
use the Calibration Utility on a MACINTOSH system.

Appendix A: Kodak XLS 8600 and Kodak DS 8650 Printers —describes 
the printer ribbon media choices for these printers and gives instructions 
for downloading new calibration tables for your printer.

Index —a comprehensive index is included.
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1 Calibration Utility for 
MICROSOFT WINDOWS

This chapter describes how to install and use the Calibration Utility on a
system that uses Microsoft Windows 3.1, Windows for Workgroups 3.11,
or Windows 95. You should be familiar with the Windows environment.

Installation
See the "Read Me" for instructions for installing the calibration utility.

System Requirements

Recommended System Configuration

� 486 or Pentium processor

� MS-DOS, version 6.22 or later

� Microsoft Windows for Workgroups 3.11 or Windows 95

� 16 MB of RAM

� 4 MB of hard disk space

� CD-ROM drive

� color monitor

Minimum System Configuration

� 386 processor

� MS-DOS, version 5.0 or later

� Microsoft Windows 3.1, Windows for Workgroups 3.11, or Windows 95

� 8 MB of RAM

� 4 MB of hard disk space

� standard color or black and white monitor 
(standard VGA; minimum resolution 640 x 480 pixels)
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Installing the Software
This section describes how to install the Calibration Utility. Follow the
steps for your particular Windows system.

Windows 3.1x
1. Place the Calibration Utility CD or diskette in the appropriate drive.

2. Open and read the readme.wri file (which contains last-minute
changes and information).

3. Open the Program Manager window.

4. Pull down the File menu and select Run.

5. Type d:\setup  <enter>.

NOTE: Replace “d” in the above command with the appropriate drive
letter, if necessary.

IMPORTANT: Other executable files are on the disk (_mssetup.exe 
and _mstest.exe). If you run either of these programs, 
you will not be able to install the Calibration Utility.

The installation begins. Follow the instructions that appear on the 
screen. When the installation is complete, a confirmation box appears.

6. Click on the Continue button.

Windows restarts. A new group named Kodak Calibration Utility
appears in the Program Manager window.

7. Remove the CD or diskette from the drive.

Windows 95
1. Place the Calibration Utility CD or diskette in the appropriate drive.

2. Open and read the readme.wri file (which contains last-minute
changes and information).

3. Double-click on the My Computer icon.

4. Double-click on the appropriate drive.

5. Double-click on the setup.exe icon.

IMPORTANT: Other executable files are on the disk (_mssetup.exe 
and _mstest.exe). If you run either of these programs, 
you will not be able to install the Calibration Utility.

The installation begins. Follow the instructions that appear on the 
screen. When the installation is complete, a confirmation box appears.

6. Click on the Continue button.

7. Remove the CD or diskette from the drive.

This page has been intentionally left blank.
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Operating the Calibration Utility
The following steps describe how to start the Calibration Utility.

NOTE: The export module for the printer you want to calibrate must be
installed before you start the Calibration Utility. The Calibration
Utility prompts you for the location of the folder containing the
export module.

If you use another version of Windows, your dialog boxes will look
slightly different than those shown in this chapter.

Starting in Windows 3.1x
1. Double-click on the Kodak DS Calibration Utility group icon in the

Program Manager window.

The Kodak Calibration Utility window opens.

2. Double-click on the Kodak DS Calibration Utility icon.

A splash screen appears, then the Calibration Utility selection 
dialog appears.

NOTE: If this is the first time that the Calibration Utility has been 
run, or if there are no printers on the Select Printer drop-down 
list, or if the Preferences files have been deleted, you must 
select and open the export module for the printer that you 
want to calibrate.

3. Do one of the following:

� Click on the Begin Easy Cal button to start up Easy Cal.

Information about the Easy Cal calibration procedure is in “Using
Easy Cal to Calibrate Your Printer” on page 1–6.

or

� Click on the Launch Normal Utility button to start up Normal Utility.

Information about the Normal Utility calibration procedure is in
“Using Normal Utility to Calibrate Your Printer” on page 1–16.
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NOTE: If you want to go directly to Normal Utility without the Calibration 
Utility selection dialog appearing each time you start the Calibration 
Utility, select the check box labeled At start-up, launch normal 
utility and don’t show this screen. The corresponding check box 
(Show Easy Cal selection screen at start-up) in the Preferences 
dialog box (accessed from the File menu) is deselected.

To use Easy Cal from within Normal Utility, pull down the Easy-Cal 
menu and select Begin... or Begin with Previous Settings....

If you want the Calibration Utility selection box to appear when 
you start up the Calibration Utility, select the Show Easy Cal 
selection screen at start-up check box in the Preferences dialog box.

For more information about the options in the Preferences dialog
box, refer to “Option Descriptions” on page 1–45.

Starting in Windows 95
1. Click on the Start button.

2. Select Programs on the Start menu.

3. Select Kodak DS Calibration Utility on the Programs menu.

4. Select Kodak DS Calibration Utility on the Kodak DS Calibration 
Utility menu.

A splash screen appears, then the Calibration Utility selection 
dialog appears.

NOTE: If this is the first time that the Calibration Utility has been 
run, or if there are no printers on the Select Printer drop-down 
list, or if the Preferences files have been deleted, you must 
select and open the export module for the printer that you 
want to calibrate.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MICROSOFT WINDOWS

1–5Part No. 1H9659   September 1997

5. Do one of the following:

� Click on the Begin Easy Cal button to start up Easy Cal.

Information about the Easy Cal calibration procedure is in “Using
Easy Cal to Calibrate Your Printer” on page 1–6.

or

� Click on the Launch Normal Utility button to start up Normal Utility.

Information about the Normal Utility calibration procedure is in
“Using Normal Utility to Calibrate Your Printer” on page 1–16.

NOTE: If you want to go directly to Normal Utility without the Calibration 
Utility selection dialog appearing each time you start the Calibration 
Utility, select the check box labeled At start-up, launch normal 
utility and don’t show this screen. The corresponding check box 
(Show Easy Cal selection screen at start-up) in the Preferences 
dialog box (accessed from the File menu) is deselected.

To use Easy Cal from within Normal Utility, pull down the Easy-Cal 
menu and select Begin... or Begin with Previous Settings....

If you want the Calibration Utility selection box to appear when 
you start up the Calibration Utility, select the Show Easy Cal 
selection screen at start-up check box in the Preferences dialog box.

For more information about the options in the Preferences dialog
box, refer to “Option Descriptions” on page 1–45.
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Using Easy Cal to Calibrate Your Printer
The Easy Cal calibration procedure provides you with steps that guide
you through the process of calibrating your printer using a Visual Gray
Balance calibration.

NOTE: The Easy Cal calibration procedure cannot be used to calibrate a
printer that is using black-only ribbon.

When you click on the Begin Easy Cal button in the Calibration Utility
selection dialog, the Easy Cal calibration procedure starts up and the
following dialog box appears.

� Click on the Proceed button.

The Easy Cal Step 1 of 5 dialog box appears.

NOTE: Clicking on the Cancel button accesses Normal Utility.
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Easy Cal Step 1

The Easy Cal Step 1 dialog box allows you to select a printer model to
calibrate and find the corresponding export module.

NOTE: If you do not need to specify a different printer, click on the
Next>> button in the Easy Cal Step 1 dialog box and go to 
“Easy Cal Step 2.”

1. Select a printer on the Printer Model drop-down list.

NOTE: If there are no printers on the Printer Model drop-down list or 
the printer you want to calibrate does not appear on the list, 
you must find and select the export module for the printer that 
you want to calibrate.

2. Click on the Locate Export Modules Folder... button.

A selection box appears. This box shows the directory in which the
Calibration Utility was installed. The name of the export module
appears in the Files list.

3. Find and open the directory that contains the export module.
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4. Click on the OK button.

You return to the Easy Cal Step 1 dialog box. The Calibration Utility now 
can find and use the export module so it can transfer data to the printer.

5. Click on the Next >> button.

The Easy Cal Step 2 dialog box appears.

Easy Cal Step 2

The Easy Cal Step 2 dialog box allows you to specify a different printer to
calibrate than the one that appears in the Printer box.

NOTE: If you do not need to specify a different printer, you can ignore the
following steps and click on the Next>> button in the Easy Cal
Step 2 dialog box and go to “Easy Cal Step 3.”

1. Click on the Select Printer... button.
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The Select a Printer dialog box appears.

NOTE: Your Select Printer dialog box may appear different, depending on
your printer export module.

If this is the first time that the Calibration Utility has been run 
or if the Preferences files have been deleted, you must locate an
export module folder. At this time some export modules may
require that you locate the necessary files.

2. Click on the button for the port to which the printer is connected.

3. Click on the OK button.

You return to the Easy Cal Step 2 dialog box.
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4. Click on the Next >> button.

The Easy Cal Step 3 dialog box appears.

Easy Cal Step 3

The Easy Cal Step 3 dialog box allows you to specify a different printer
media to calibrate than the one that appears in the Printer Setup box.

1. Make sure that the paper and media types for which you want to
calibrate are loaded in the printer.

NOTE: If you do not need to specify a different printer media, you can
ignore the following steps and click on the Next>> button in 
the Easy Cal Step 3 dialog box and go to “Easy Cal Step 4.”

2. Click on the Change Setup... button.
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The Printer Setup for Calibration dialog box appears.

NOTE: Your Printer Setup for Calibration dialog box may appear different,
depending on your printer export module.

3. Make any necessary changes in the Printer Setup for Calibration
dialog box.

4. Click on the OK button.

You return to the Easy Cal Step 3 dialog box.

5. Click on the Next >> button.
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The Easy Cal Step 4 dialog box appears.

Easy Cal Step 4

The Easy Cal Step 4 dialog box contains printer and printer setup
information that will be used for the test print that is created in this step.

NOTE: If the Easy Cal Step 4 dialog box does not contain printer and
printer setup information, click on the <<Back button and click 
on the Change Setup... button.

1. Make sure that the Printer and Printer Setup information is correct.

NOTE: Clicking on the Next>> button sends the default table to the
printer. The previous table is overwritten.
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2. Click on the Next >> button.

The default table is sent to the printer and the previous table is
overwritten. The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.

3. Click on the Print button.

Your computer begins processing information. This may take a few
minutes. The calibration test print is printed on the specified printer.
The Easy Cal Step 5 dialog box appears.
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Easy Cal Step 5

Use the test print to calibrate your printer in the Easy Cal Step 5 dialog box.

1. Look at the test print and decide which grayscale cluster appears 
the most neutral gray.

NOTE: If you want to print another test print, click on the <<Back button
to return to the Easy Cal Step 4 dialog box.

2. Type the number of the most neutral grayscale cluster in the Cluster
Number text box.

NOTE: If you want to print an updated test print, you can click on the
<<Back button to return to the Easy Cal Step 4 dialog box.

If cluster number 225 on the updated test print is the most neutral
gray, then the calibration is successful. Type 225 in the Cluster
Number text box and go to step 3.

3. Click on the Done button.

The printer calibration begins. When the calibration is complete, the
following dialog box appears.
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4. Do one of the following:

� If you do not want to make another test print and you do not want
to save the calibration table, click on the Exit button to quit the
Calibration Utility.

or

� If you want to save the calibration table, click on the Proceed 
button to access a document window. Refer to “Using the
Calibration Document Window” on page 1–28.

Saving Your Calibration Table

You may want to save the calibration table you just created to use as a
starting point for later calibrations.

� Pull down the File menu and select Save to save changes to the
current calibration table.

� Pull down the File menu and select Save As to access a selection box
in which you can specify a new name and location for the current
calibration table.
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Using Normal Utility to Calibrate Your Printer
The Normal Utility calibration procedure allows you to create a new
calibration document or start from a calibration document that was
previously created and saved.

When you click on the Launch Normal Utility button in the Calibration
Utility selection box, the Normal Utility calibration procedure starts up 
and the Calibration Utility window opens.

NOTE: If this is the first time that the Calibration Utility has been 
run, or if there are no printers on the Select Printer drop-down 
list, or if the Preferences files have been deleted, you must 
select and open the export module for the printer that you 
want to calibrate.

You can either create a new calibration table or open an existing one to
calibrate your printer.

� Information about creating a new calibration table is in “Creating a
New Calibration Document” on page 1–19.

� Information about using an existing calibration table is in “Opening an
Existing Calibration Table” on page 1–26.
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Setting Preferences

You can specify the folders that contains the export module and the import 
module (used for densitometer settings) in the Preferences dialog box.

1. Pull down the File menu and select Preferences.

The Preferences dialog box appears.

2. Click on the Select button next to “Printer Export Modules Folder.”

A selection box appears.

3. Find and open the folder in which the export module is located.

4. Click on the OK button.

You return to the Preferences dialog box.

5. Click on the Select button next to “Densitometer Import Modules Folder.”

A selection box appears.

6. Find and open the folder in which the import module is located.

7. Click on the OK button.

You return to the Preferences dialog box.

8. Click on the OK button.

Your selections are saved.
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Selecting and Setting Up a Printer

Select a printer and specify the printer media before you start a calibration.

1. Pull down the Printer menu.

2. Choose Select Printer and highlight the printer you want to calibrate.

3. Pull down the Printer menu and choose Printer Setup.

The Printer Setup for Calibration dialog box appears.

NOTE: The Printer Setup for Calibration dialog box may appear different,
depending on the selected printer.

4. Select the media combination(s) for which you are calibrating.

5. Click on the OK button.

The Printer Setup for Calibration dialog box closes.
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Creating a New Calibration Document

You can either create a new calibration document or open an existing
one to calibrate your printer.

1. Pull down the File menu and select New.

The Calibration Table dialog box appears.

Ribbon and paper type information may not appear in the 
Printer Setup box if you have not first used the Printer menu’s 
Printer Setup... option.

If the correct paper and media types do not appear, refer to the
previous section, “Selecting and Setting Up a Printer.” If the 
correct paper and media types appear, refer to “Selecting a 
Starting Point for the Calibration Document” on page 1–20.

NOTE: The Read Current Table From Printer radio button will not 
be available if the printer cannot return this information 
(for example, many printers connected via parallel will have 
this option deselected).
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Selecting a Starting Point for the Calibration Document

This section describes how to select a starting point (base file) for the
calibration document. There are three ways to access a base file:

� Read Current Table From Printer—uses the printer’s current table
(refer to “Using the Printer’s Current Calibration Table as the 
Starting Point” on this page).

� Use Printer’s Default Table—uses the printer’s default table (refer to
“Using the Printer’s Default Calibration Table as the Starting Point” 
on page 1–22).

� Copy Table from File—uses a previously created and saved calibration 
table (refer to “Using an Existing Calibration Table as the Starting Point”
on page 1–23).

Using the Printer’s Current Calibration Table as the Starting Point

1. Select the Read Current Table From Printer radio button in the
Starting Point box.

2. Click on the OK button.
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A Calibration Document window appears.

3. Go to “Using the Calibration Document Window” on page 1–28.
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Using the Printer’s Default Calibration Table as the Starting Point

1. Select the Use Printer’s Default Table radio button in the Starting
Point box.

2. Click on the OK button.

A Calibration Document window appears.

3. Go to “Using the Calibration Document Window” on page 1–28.
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Using an Existing Calibration Table as the Starting Point

You can follow the steps below only if you have previously created and
saved a calibration table. If you are using the Calibration Utility for the
first time, no calibration tables exist yet for use as a starting point.

The table you select to use as a starting point does not contain printer setup 
information. Follow the instructions in “Selecting and Setting Up a Printer” 
on page 1–18 to specify information about the printer paper and media.

1. Select the Copy Table from File: radio button in the Starting Point box.

2. Click on the Select File... button.

A file selection dialog box appears.
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3. Find and open the directory that contains the calibration table you
want to use as the starting point for your new table.

4. Select the calibration table you want to copy.

NOTE: The data in the table selected as a starting point is specific to the
paper and media types specified when the table was created. You
cannot select documents for the incorrect paper and ribbon type.

The files you can select are files created by the Calibration 
Utility or any file that has a .kcu extension. However, you can 
only choose tables that are configured for that particular printer
and media.

5. Click on the Open button.

The file selection dialog box closes. The name of the selected
calibration table appears after the Copy Table from File: radio button.

6. Click on the OK button.
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A Calibration Document window appears.

7. Go to “Using the Calibration Document Window” on page 1–28.
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Opening an Existing Calibration Table

1. Pull down the File menu and select Open.

A file selection dialog box appears.

2. Find and open the directory that contains the calibration table you
want to use.

3. Select the calibration table you want to use.

4. Click on the Open button.
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A Calibration Document window appears.

5. Go to “Using the Calibration Document Window” on page 1–28.
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Using the Calibration Document Window

Use the Calibration Document window to set up and run Visual Gray
Balance, Visual Linearity, and Densitometer calibrations.

1. Make sure that the information in the Printer Setup Information 
box is correct and make sure that you are creating a calibration 
table for the media you want to use.

2. Type information about the printer you are calibrating in the Printer
Description text box.

3. Type information about the media combination for which you are
calibrating in the Media Description text box.

NOTE: Entries in the Printer Description and Media Description text
boxes are optional and do not appear on the test print.

You can calibrate your printer. Refer to “Calibrating the Printer” 
on page 1–29.

NOTE: If you are using black-only media, you cannot use the Visual Gray
Balance calibration method to calibrate your printer. You must go
directly to the Visual Linearity calibration procedure.
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Calibrating the Printer

You can now calibrate your printer by running the Visual Gray Balance
and Visual Linearity calibration procedures.

If you have a densitometer, you can run just the Densitometer calibration
procedure. You do not have to do Visual Gray Balance and Visual
Linearity calibrations. Refer to “Running a Densitometer Calibration” 
on page 1–40.

Visual Gray Balance

Visual Gray Balance calibrates your printer so it produces a neutral 
gray. The Calibration Utility allows you to select from three Visual Gray
Balance calibration prints. Each of these prints presents 49 numbered
grayscale clusters. Each cluster is made up of four boxes of varying
densities. A Visual Gray Balance calibration print looks similar to the
following example.

���

The clusters on the three prints include a range of colors. Clusters in the
upper left corner will have a green hue. Clusters in the lower right corner
will have a magenta hue. Three different calibration prints allow you to
choose the degree of color shift.

NormalFine Coarse
Somewhat Green

Somewhat Magenta

Slightly Green

Slightly Magenta

Very Green

Very Magenta
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Fine—offers the least degree of difference between clusters. This print 
is useful when it is difficult to choose between clusters on the Normal
calibration print.

For example, you printed a Normal print and you find that the most
neutral-looking clusters are next to each other, but one still looks 
slightly green while the other still looks slightly magenta. You can 
print a Fine calibration print to get more choices within a smaller 
range of colors.

Normal —offers a moderate degree of difference between clusters. 
The amount of correction in this print is appropriate for most 
calibration jobs.

Coarse —offers the greatest degree of difference in clusters. This 
print is useful when neutral areas in your prints appear very green 
or very magenta.

Running a Visual Gray Balance Calibration

1. Pull down the Calibration menu and select Visual Gray Balance.

2. Pull down the Calibration menu and select Setup Visual Gray Balance....

The Calibration Setup – Visual Gray Balance dialog box opens.

3. Select a radio button in the Amount of Correction box.
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4. Click on the OK button.

You return to the Calibration Document window.

5. Click on the Send & Print button.

The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.
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6. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.

7. View the calibration test print and determine which cluster appears
the most neutral.

If the Visual Gray Balance most-neutral cluster number on the 
test print ends in 25, the printer is already calibrated. You should 
now perform a Visual Linearity calibration.

If the Visual Gray Balance number on the test print does not 
end in 25, you must recalibrate the printer to the most neutral 
cluster number.

NOTE: If you enter a value that ends in 25, the calibration table does 
not change.

8. Click on the Input button.
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The Input Test Print Values dialog box appears.

9. Type the number of the most-neutral cluster in the Cluster Number box.

10. Click on the Recompute the Table button.

The calibration table data is updated and the Calibration Document
window appears.
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11. Click on the Send  button if you are satisfied with the neutral in the cluster 
you selected and you do not want to look at another calibration print.

A confirmation box appears.

12. Click on the Send button.

The recomputed table is sent to the printer and the following 
message appears.

13. Click on the OK button.

The calibration table is computed using the specified values and 
you return to the Calibration Document window. You should now
perform a Visual Linearity calibration.

NOTE: You should make another test print to verify your input 
value adjustments.
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Visual Linearity

Visual Linearity calibrates your printer so it produces the correct shading
(lightness/darkness).

Use the Linearity Reference Card to select a cluster for each of the six
density ranges. Visual Linearity calibration prints look similar to the
following examples.

CMYKCMY K

Using the Linearity Reference Card

The Linearity Reference Card is included with the Calibration Utility. 
Use this Reference Card for performing Visual Linearity calibrations.
Following are instructions for using the Reference Card.

1. Lay the Linearity Reference Card with the name at the top on the first
row of the calibration print.

NOTE: It may not be possible to find a cluster in which all six gray levels
exactly match the Linearity Reference Card. Select the cluster
that appears to be the closest match.

2. Slide the Linearity Reference Card across each patch in the row 
and determine which of the nine patches in the row most closely
matches the darkness on the Reference Card.

NOTE: Match the darkness on the Reference Card, not the color.

3. Repeat step 2 for each row on the calibration print.
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Running a Visual Linearity Calibration

After you have run a calibration using the Visual Gray Balance option,
use the Visual Linearity option to recompute the current calibration 
table using values from the test print.

1. Pull down the Calibration menu and select Visual Linearity.

You return to the Calibration Document window.

2. Click on the Send & Print button.
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The Send and Print dialog box opens.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.

3. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.
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4. Use the Linearity Reference Card to select a box number for each of
the six density ranges.

If all of the Visual Linearity numbers on the test print are box number 5, 
the printer is already calibrated. You can close the Calibration Utility.

If the Visual Linearity numbers on the test print are not all box number 5, 
you must recalibrate the printer. Go to step 5.

5. Click on the Input button.

The Input Test Print Values dialog box opens.

6. Type in the values you select from the test print in the text boxes.

7. Click on the Recompute the Table button.

The calibration table is computed using the specified values and the
Calibration Document window appears.

8. Click on the Send  button to send the table to the printer.
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Densitometer

A Densitometer calibration corrects the printer’s response based on the 
densitometer reading for selected patches. If you have a densitometer, you 
do not need to run Visual Gray Balance and Visual Linearity calibrations. 
You only have to run the Densitometer calibration.

Print a test print and read it with a densitometer. There are two kinds of
densitometer prints: process and separation. The kind of print you get
depends on your printer. Densitometer calibration prints look similar to
the following examples.

CMYK
Process Densitometer Prints

CMY K

example: from a Kodak XLS 8600 Printer or Kodak Digital Science� 8650 Printer

Separations Densitometer Prints

example: from a Kodak Digital Science� DCP 9000 Printer

CMYKCMY K

NOTE: Separation prints have separate individual colors for each of the
cyan, magenta, and yellow planes. Process prints combine the
cyan, magenta, and yellow into a single gray column. Black is
always a separate column.

Using a densitometer, you enter the density results for each of the
patches in the Densitometer Input Test Print Values dialog box. In
each case, you always input the visual component for the patch.

For separations prints, enter the “C” component for the cyan
patches, the “M” component for the magenta patches, and the 
“Y” component for the yellow patches.

For process prints, enter the “C,”  “M,” and “Y” components for
each of the CMY patches.
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Running a Densitometer Calibration

If you have a densitometer, you can run the Densitometer calibration
instead of the Visual Gray Balance and Visual Linearity calibrations.

1. Set up your densitometer.

2. Pull down the Calibration menu and select Densitometer.

3. Pull down the Calibration menu and select Setup Densitometer....

The Calibration Setup – Densitometer dialog box appears.

4. Select a densitometer status in the Densitometer box.

5. Pull down the Number of Squares menu in the Test Print box and
select the number of squares in your test print.

6. Click on the OK button.
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You return to the Calibration Document window.

7. Click on the Send & Print button.

The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.
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8. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.

9. Click on the Input button.

The Input Test Print Values dialog box appears.
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One, three, or four Density Value columns appear in the Input Test
Print Values dialog box, depending on the calibration your printer
requires (for black ribbon, three-color ribbon, or four-color ribbon).

The number of Density Value rows is determined by the selection 
in the Number of Squares menu (15 or 38).

Valid characters in this dialog box include numbers from 0 to 9,
periods (.), and commas (,). The valid range is 0 to 3.999 
(0 to 3,999). Move from cell to cell using your keyboard’s 
arrow keys. You can copy and paste any group of contiguous 
fields in a rectangular pattern.

10. Type the test print values in the text boxes.

NOTE: You can import densitometer data automatically with an 
import module. If your densitometer has an associated import
module, the densitometer readings will be imported directly into
the dialog box. Using the Kodak File Reader, you can read in 
a file of data and specify the end of Field and End of Record
characters. For more information, refer to “Import” on 
page 1–44.

11. Click on the Recompute the Table button.

The calibration table is computed using the specified values and the
Calibration Document window appears.
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Import

The selected import module opens a dialog box when you click on the
Import button in the Densitometer — Input Test Print Values dialog box.
For the Kodak File Reader, the following dialog box appears when you
click on the Import button.

End of Field Character —specify the end-of-field character used in 
your densitometer file: “space,” “comma,” “tab,” “CR” (carriage return),
“CR-LF” (carriage return/line feed), “LF” (line feed), and “Semi-colon.”

End of Record Character —specify the end-of-record character used 
in your densitometer file: “space,” “comma,” “tab,” “CR” (carriage return),
“CR-LF” (carriage return/line feed), “LF” (line feed), and “Semi-colon.”

Open—the Open button allows you to find and import the densitometer
file with the values you want to use in the Input Test Print Values 
dialog box.
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Option Descriptions
This section describes the Calibration Utility menu and dialog box options.

File Menu
This section describes the features on the File pulldown menu.

New—accesses the Calibration Document window so you can select
options for the current printer setup.

Open—accesses a file selection box so you can select an existing
calibration table from which to start.

Close —closes the current calibration document.

Save—saves changes to the current calibration document. When you 
name a calibration document, you may want to include characters that 
indicate the selected media types. Saving a document this way allows you 
to select it later to use as a starting point for a new calibration document.

Save As... —accesses a dialog box in which you can specify a new 
name and location for the current calibration settings. When you name 
a calibration document, you may want to include characters that indicate
the selected media types. Naming a document this way allows you to
select it later to use as a starting point for a calibration document.

Revert —returns a calibration document to its original state. All
recomputations are discarded.

Preferences... —accesses a dialog box that allows you to specify the
folder containing the export module and the folder containing the import
module (used for densitometer settings).

Exit —exits the Calibration Utility.
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Edit Menu
The Edit menu is enabled only when a Calibration Document window 
is open.

The options in the Edit menu are enabled only when you enter text in the
Printer Description and Media Description boxes.

Calibration Menu
The Calibration menu is enabled when a Calibration Document window is
open. You can choose to calibrate based on your input to the Visual Gray
Balance, Visual Linearity, and Densitometer dialog boxes.

Calibration Setup — Visual Gray Balance

This dialog box allows you to specify the degree of correction to apply
with the current calibration table.

NOTE: If you are using black-only media, you cannot use the Visual Gray
Balance calibration method to calibrate your printer.
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Amount of Correction

The Amount of Correction radio buttons allow you to specify the degree
of difference between neutrals the calibration print will present.

Fine—the calibration print offers the least degree of difference in neutrals
between the cluster in the upper left corner and the cluster in the lower
right corner. The cluster in the upper left corner is only slightly green and
the cluster in the lower right corner is only slightly magenta.

Select “Fine” to get the smallest hue range. This means that the hue
differences between clusters is small so you can fine-tune by choosing
between very similar neutrals.

Normal —the calibration print offers a moderate degree of difference in
neutrals between the cluster in the upper left corner and the cluster in the
lower right corner. The cluster in the upper left corner is somewhat green
and the cluster in the lower right corner is somewhat magenta.

Select “Normal” to get a larger hue range than “Fine.” This means that
the hue differences between clusters is slightly larger and adjacent
clusters are less similar.

Coarse —the calibration print offers the greatest degree of difference in
neutrals between the cluster in the upper left corner and the cluster in the
lower right corner. The cluster in the upper left corner is distinctly green
and the cluster in the lower right corner is distinctly magenta.

Select “Coarse” to get the largest hue range. This means that the hue
differences between clusters is easily discernible and adjacent clusters
are distinctly different.

Calibration Setup — Visual Linearity

There is no functionality for this option at this time.
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Calibration Setup — Densitometer

This dialog box allows you to use values from a densitometer text table
to recompute the calibration table.

NOTE: Make sure that your densitometer is calibrated before you try to
calibrate your printer with the densitometer values.

Densitometer

The Densitometer radio buttons allow you to specify what type of density
data (Status A or Status T) your densitometer provides. The Calibration
Utility calculates the table data using the density type that the export
module needs for the current calibration slot.

NOTE: Depending on the export module and settings, one of these
options may not be available. For example, Status A is not
available for the Kodak Digital Science� DCP 9000 Printer.

Test Print — Number of Squares

The Number of Squares menu in the Test Print box allows you to specify
the number of squares (15 or 38) in your test print.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MICROSOFT WINDOWS

1–49Part No. 1H9659   September 1997

Printer Menu
The Printer menu allows you to select a printer or set up the printer 
from the menu bar.

Select Printer —a menu with the printer selections for your 
system appears.

Printer Setup... —the Printer Setup for Calibration dialog box appears 
so you can make changes for the selected printer.

Easy-Cal Menu
The Easy-Cal menu allows you to start the Easy Cal calibration
procedure from the menu bar.

Begin... —the Easy Cal calibration procedure starts up.

Begin with Previous Settings... —the Easy Cal Step 4 dialog 
box appears.

NOTE: The Easy Cal calibration procedure cannot be used to calibrate 
a printer that is using black-only ribbon.
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Calibration Table Dialog Box
Pull down the File menu and select New to access a dialog box that
allows you to create a new calibration table.

Printer Setup

The Printer Setup box lists information about the ribbon and paper type
for which the printer will be calibrated. Click on the Change Setup button
to change the information that appears.

Change Setup —accesses the Printer Setup for Calibration dialog 
box so you can select options that match the media in the printer 
you are calibrating.
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Starting Point

The Starting Point box allows you to select the data that will act as a
base for the new calibration table.

Read Current Table From Printer —allows you to retrieve and begin
with the printer’s current table. Once the table is loaded, you can edit 
it and recalibrate the printer. This option is not always available as a
starting point.

Use Printer’s Default Table —default printer data acts as the starting
point for the new calibration document.

Copy Table from File —the calibration table you select with the Select
File button acts as the starting point for the new calibration document.

Select File —opens a selection box so you can choose an existing
calibration document from which to start.

OK

The OK button closes the dialog box and opens a Calibration Document
window. Refer to “Calibration Document Window” on page 1–52 for 
more information.

Cancel

The Cancel button closes the dialog box without creating a new
calibration document.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MICROSOFT WINDOWS

1–52 September 1997   Part No. 1H9659

Calibration Document Window
The Calibration Document window allows you to specify information
about the calibration table.

Printer Setup Information

The Printer Setup Information box lists information about the printer type,
ribbon, and paper type for which the printer will be calibrated.
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Printer Description

The Printer Description text box allows you to enter information that
describes the printer for which the calibration table will be used. The text
you enter is used to help describe the specifics of a particular calibration
table. This text is not printed on the test print. An entry is optional. Use
the Edit menu when you enter text.

Media Description

The Media Description text box allows you to enter information that
describes the media for which the calibration table will be used. The text
you enter is used to help describe the specifics of a particular calibration
table. This text is not printed on the test print. An entry is optional. Use
the Edit menu when you enter text.

Calibration Tools

Calibration Tools offers handling options for the calibration table.

Send & Print —sends the current calibration table to the printer. 
A calibration print is generated so you can evaluate the results.

Input —accesses the Input Test Print Values dialog boxes so you can
enter Visual Gray Balance, Visual Linearity, and Densitometer data.

Send—sends the current calibration table to the printer without
generating a calibration print. This button is usually used after you 
have created a test print and have recomputed the calibration table.
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2 Calibration Utility for MACIN TOSH
This chapter describes how to install and use the Calibration Utility on a 
Macintosh system. You should be familiar with the Macintosh environment.

Installation
See the "Read Me" for instructions for installing the calibration utility.

System Requirements

Recommended System Configuration

� 68040 or PowerPC processor

� APPLE System 7.5

� 16 MB of RAM

� color monitor

� CD-ROM drive

Minimum System Configuration

� 68030 processor

� APPLE System 7.1

� 8 MB of RAM

� standard color or black and white monitor 
(minimum resolution 640 x 400 pixels)
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Installing the Software
1. Place the CD or diskette containing the Calibration Utility in the

appropriate drive.

An icon appears on the desktop.

2. Open and read the README file (which contains last-minute 
changes and information).

3. Open a folder on your hard drive in which you want to place the
Calibration Utility.

4. Double-click on the icon to open it.

5. Select the Kodak DS Calibration Utility folder and drag it into the
folder you created on your hard drive.

The entire contents of the folder on the CD or diskette are copied 
into the folder you created.

6. Remove the CD or diskette from the drive.

The Calibration Utility is ready to run.This page has been intentionally left blank.
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Operating the Calibration Utility
The following steps describe how to start the Calibration Utility.

1. Double-click on the Kodak DS Calibration Utility icon on your hard drive.

A splash screen appears, then the Calibration Utility selection 
box appears.

2. Do one of the following:

� Click on the Begin Easy Cal button to start up Easy Cal.

Information about the Easy Cal calibration procedure is in “Using
Easy Cal to Calibrate Your Printer” on page 2–4.

or

� Click on the Launch Normal Utility button to start up Normal Utility.

Information about the Normal Utility calibration procedure is in
“Using Normal Utility to Calibrate Your Printer” on page 2–14.

NOTE: If you want to go directly to Normal Utility without the Calibration 
Utility selection dialog appearing each time you start the Calibration 
Utility, select the check box labeled At start-up, launch normal 
utility and don’t show this screen. The corresponding check box 
(Show Easy Cal selection screen at start-up) in the Preferences 
dialog box (accessed from the File menu) is deselected.

To use Easy Cal from within Normal Utility, pull down the Easy-Cal 
menu and select Begin... or Begin with Previous Settings....

If you want the Calibration Utility selection box to appear when 
you start up the Calibration Utility, select the Show Easy Cal 
selection screen at start-up check box in the Preferences dialog box.

For more information about the options in the Preferences dialog
box, refer to “Option Descriptions” on page 2–41.
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Using Easy Cal to Calibrate Your Printer
The Easy Cal calibration procedure provides you with steps that guide
you through the process of calibrating your printer using a Visual Gray
Balance calibration.

NOTE: The Easy Cal calibration procedure cannot be used to calibrate a
printer that is using black-only ribbon.

When you click on the Begin Easy Cal button in the Calibration Utility
selection dialog, the Easy Cal calibration procedure starts up and the
following dialog box appears.

� Click on the Proceed button.

The Easy Cal Step 1 of 5 dialog box appears.

NOTE: Clicking on the Cancel button accesses Normal Utility.
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Easy Cal Step 1

The Easy Cal Step 1 dialog box allows you to select a printer model to
calibrate and find the corresponding export module.

If you do not need to specify a different printer, click on the Next>> button
in the Easy Cal Step 1 dialog box and go to “Easy Cal Step 2.”

1. Select a printer on the Printer Model menu.

NOTE: If there are no printers on the Printer Model menu or the printer
you want to calibrate does not appear on the menu, you must 
find and select the export module for the printer that you want 
to calibrate.

2. Click on the Locate Export Modules Folder... button.

A selection box appears. The selection box shows the folder in which
the Calibration Utility was installed. The name of the export module
appears in the Files list.
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3. Find and open the folder that contains the export module.

4. Select the export module you want to use.

5. Click on Open button.

You return to the Easy Cal Step 1 dialog box. The Calibration Utility
now can find and use the export module so it can transfer data to 
the printer.

6. Click on the Next >> button.

The Easy Cal Step 2 dialog box appears.
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Easy Cal Step 2

The Easy Cal Step 2 dialog box allows you to specify a different printer to
calibrate than the one that appears in the Printer box.

NOTE: If you do not need to specify a different printer, you can ignore the
following steps and click on the Next>> button in the Easy Cal
Step 2 dialog box and go to “Easy Cal Step 3.”

1. Click on the Select Printer... button.

The Select Printer dialog box appears.

NOTE: Your Select Printer dialog box may appear different, depending on
your printer export module.

If this is the first time that the Calibration Utility has been 
run or if the Preferences files have been deleted, you may be
prompted to locate the necessary files for the export module.

2. Click on the button for the port to which the printer is connected.

3. Click on the OK button.
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You return to the Easy Cal Step 2 dialog box.

4. Click on the Next >> button.

The Easy Cal Step 3 dialog box appears.
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Easy Cal Step 3

The Easy Cal Step 3 dialog box allows you to specify a different printer
media to calibrate than the one that appears in the Printer Setup box.

1. Make sure that the paper and media types for which you want to
calibrate are loaded in the printer.

NOTE: If you do not need to specify a different printer media, you can
ignore the following steps and click on the Next>> button in 
the Easy Cal Step 3 dialog box and go to “Easy Cal Step 4.”

2. Click on the Change Setup... button.

The Printer Setup for Calibration dialog box appears.

NOTE: Your Printer Setup for Calibration dialog box may appear different,
depending on your printer export module.
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3. Make any necessary changes in the Printer Setup for Calibration
dialog box.

4. Click on the OK button.

You return to the Easy Cal Step 3 dialog box.

5. Click on the Next >> button.

The Easy Cal Step 4 dialog box appears.
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Easy Cal Step 4

The Easy Cal Step 4 dialog box contains printer and printer setup
information that will be used in the test print that is created in this step.

NOTE: If the Easy Cal Step 4 dialog box does not contain printer and
printer setup information, click on the <<Back button and click 
on the Change Setup... button.

1. Make sure that the Printer and Printer Setup information is correct.

NOTE: Clicking on the Next>> button sends the default table to the
printer. The previous table is overwritten.

2. Click on the Next >> button.

The default table is sent to the printer and the previous table is
overwritten. The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.
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3. Click on the Print button.

Your computer begins processing information. This may take a few
minutes. The calibration test print is printed on the specified printer.
The Easy Cal Step 5 dialog box appears.

Easy Cal Step 5

Use the test print to calibrate your printer in the Easy Cal Step 5 dialog box.

1. Look at the test print and decide which grayscale cluster appears 
the most neutral gray.

NOTE: If you want to print another test print, click on the <<Back button
to return to the Easy Cal Step 4 dialog box.

2. Type the number of the most neutral grayscale cluster in the Cluster
Number text box.
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NOTE: If you want to print an updated test print, you can click on the
<<Back button to return to the Easy Cal Step 4 dialog box.

If cluster number 225 on the updated test print is the most neutral
gray, then the calibration is successful. Type 225 in the Cluster
Number text box and go to step 3.

3. Click on the Done button.

The printer calibration begins. When the calibration is complete, the
following dialog box appears.

4. Do one of the following:

� If you do not want to make another test print and you do not want
to save the calibration table, click on the Quit button to quit the
Calibration Utility.

or

� If you want to save the calibration table, click on the Proceed 
button to access a document window. Refer to “Using the
Calibration Document Window” on page 2–24.

Saving Your Calibration Table

You may want to save the calibration table you just created to use as a
starting point for later calibrations.

� Pull down the File menu and select Save to save changes to the
current calibration table.

� Pull down the File menu and select Save As to access a selection box
in which you can specify a new name and location for the current
calibration table.
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Using Normal Utility to Calibrate Your Printer
The Normal Utility calibration procedure allows you to create a new
calibration document or start from a calibration document that was
previously created and saved.

When you click on the Launch Normal Utility button in the Calibration
Utility selection box, the Normal Utility calibration procedure starts up 
and the Printer Calibration Utility window opens.

NOTE: If this is the first time that the Calibration Utility has been 
run, or if there are no printers on the Select Printer menu, or 
if the Preferences files have been deleted, you must select 
and open the export module for the printer that you want 
to calibrate.

You can either create a new calibration table or open an existing one to
calibrate your printer.

� Information about creating a new calibration table is in “Creating a
New Calibration Document” on page 2–17.

� Information about using an existing calibration table is in “Opening an
Existing Calibration Table” on page 2–23.
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Setting Preferences

You can specify the folders that contains the export module and the import 
module (used for densitometer settings) in the Preferences dialog box.

1. Pull down the File menu and select Preferences.

The Preferences dialog box appears.

2. Click on the Select button next to “Printer Export Modules Folder.”

A file selection dialog box appears.

3. Find and open the folder in which the export module is located.

4. Click on the OK button.

You return to the Preferences dialog box.

5. Click on the Select button next to “Densitometer Import Modules Folder.”

A file selection dialog box appears.

6. Find and open the folder in which the import module is located.

7. Click on the OK button.

You return to the Preferences dialog box.

8. Click on the OK button.

Your selections are saved.
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Selecting and Setting Up a Printer

Select a printer and specify the printer media before you start a calibration.

1. Pull down the Printer menu.

2. Choose Select Printer and highlight the printer you want to calibrate.

3. Pull down the Printer menu and choose Printer Setup.

The Printer Setup for Calibration dialog box appears.

NOTE: The Printer Setup for Calibration dialog box may appear different,
depending on the selected printer.

4. Select the media combination(s) for which you are calibrating.

5. Click on the OK button.

The Printer Setup for Calibration dialog box closes.
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Creating a New Calibration Document

You can either create a new calibration document or open an existing
one to calibrate your printer.

1. Pull down the File menu and select New.

The Calibration Table dialog box appears.

Ribbon and paper type information may not appear in the 
Printer Setup box if you have not first used the Printer menu’s 
Printer Setup... option.

If the correct paper and media types do not appear, refer to the 
previous section, “Selecting and Setting Up a Printer.” If the 
correct paper and media types appear, refer to “Selecting a 
Starting Point for the Calibration Document” on page 2–18.

NOTE: The Read Current Table From Printer radio button will not 
be available if the printer cannot return this information 
(for example, many printers connected via parallel will 
have this option deselected).
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Selecting a Starting Point for the Calibration Document

This section describes how to select a starting point (base file) for the
calibration document. There are three ways to access a base file:

� Read Current Table from Printer—uses the printer’s current table (refer
to “Using the Printer’s Current Calibration Table as the Starting Point”
on this page).

� Use Printer’s Default Table—uses the printer’s default table (refer to
“Using the Printer’s Default Calibration Table as the Starting Point” 
on page 2–20).

� Copy Table from File—uses a previously created and saved calibration 
table (refer to “Using an Existing Calibration Table as the Starting Point”
on page 2–21).

Using the Printer’s Current Calibration Table as the Starting Point

1. Select the Read Current Table from Printer radio button in the Starting
Point box.

2. Click on the OK button.
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A Calibration Document window appears.

3. Go to “Using the Calibration Document Window” on page 2–24.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MACINTOSH

2–20 September 1997   Part No. 1H9659

Using the Printer’s Default Calibration Table as the Starting Point

1. Select the Use Printer’s Default Table radio button in the Starting
Point box.

2. Click on the OK button.

A Calibration Document window appears.

3. Go to “Using the Calibration Document Window” on page 2–24.
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Using an Existing Calibration Table as the Starting Point

You can follow the steps below only if you have previously created and
saved a calibration table. If you are using the Calibration Utility for the
first time, no calibration tables exist yet for use as a starting point.

The table you select to use as a starting point does not contain printer
setup information. Follow the instructions in “Selecting and Setting Up 
a Printer” on page 2–16 to specify information about the printer paper
and media.

1. Select the Copy Table from File: radio button in the Starting Point box.

2. Click on the Select File... button.

A file selection dialog box appears.

3. Find and open the folder that contains the calibration table you want
to use as the starting point for your new table.

4. Select the calibration table you want to copy.
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NOTE: The data in the table selected as a starting point is specific to the 
paper and media types specified when the table was created. You 
cannot select documents for the incorrect paper and ribbon type.

The files you can select are files created by the Calibration Utility or 
any file that has a .kcu extension. However, you can only choose 
tables that are configured for that particular printer and media.

5. Click on the Open button.

The file selection dialog box closes. The name of the selected
calibration table appears after the Copy Table from File: radio button.

6. Click on the OK button.

A Calibration Document window appears.

7. Go to “Using the Calibration Document Window” on page 2–24.
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Opening an Existing Calibration Table

1. Pull down the File menu and select Open.

A file selection dialog box appears.

2. Find and open the folder that contains the calibration table you 
want to use.

3. Select the calibration table you want to use.

4. Click on the Open button.

A Calibration Document window appears.

5. Go to “Using the Calibration Document Window” on page 2–24.
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Using the Calibration Document Window

Use the Calibration Document window to set up and run Visual Gray
Balance, Visual Linearity, and Densitometer calibrations.

1. Make sure that the information in the Printer Setup Information box 
is correct and make sure that you are creating a calibration table for
the media you want to use.

2. Type information about the printer you are calibrating in the Printer
Description text box.

3. Type information about the media combination for which you are
calibrating in the Media Description text box.

NOTE: Entries in the Printer Description and Media Description text
boxes are optional and do not appear on the test print.

You can calibrate your printer. Refer to “Calibrating the Printer” 
on page 2–25.

NOTE: If you are using black-only media, you cannot use the Visual Gray
Balance calibration method to calibrate your printer. You must go
directly to the Visual Linearity calibration procedure.
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Calibrating the Printer

You can now calibrate your printer by running the Visual Gray Balance
and Visual Linearity calibration procedures.

If you have a densitometer, you can run just the Densitometer calibration
procedure. You do not have to do Visual Gray Balance and Visual
Linearity calibrations. Refer to “Running a Densitometer Calibration” 
on page 2–36.

Visual Gray Balance

Visual Gray Balance calibrates your printer so it produces a neutral gray. 
The Calibration Utility allows you to select from three Visual Gray Balance 
calibration prints. Each of these prints presents 49 numbered grayscale 
clusters. Each cluster is made up of four boxes of varying densities. A Visual 
Gray Balance calibration print looks similar to the following example.

���

The clusters on the three prints include a range of colors. Clusters in the
upper left corner will have a green hue. Clusters in the lower right corner
will have a magenta hue. Three different calibration prints allow you to
choose the degree of color shift.

NormalFine Coarse
Somewhat Green

Somewhat Magenta

Slightly Green

Slightly Magenta

Very Green

Very Magenta
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Fine—offers the least degree of difference between clusters. This print 
is useful when it is difficult to choose between clusters on the Normal
calibration print.

For example, you printed a Normal print and you find that the most
neutral-looking clusters are next to each other, but one still looks slightly
green while the other still looks slightly magenta. You can print a Fine
calibration print to get more choices within a smaller range of colors.

Normal —offers a moderate degree of difference between clusters. 
The amount of correction in this print will be appropriate for most
calibration jobs.

Coarse —offers the greatest degree of difference in clusters. This 
print is useful when neutral areas in your prints appear very green 
or very magenta.

Running a Visual Gray Balance Calibration

1. Pull down the Calibration menu and select Visual Gray Balance.

2. Pull down the Calibration menu and select Setup Visual Gray Balance....

The Calibration Setup – Visual Gray Balance dialog box opens.

3. Select a radio button in the Amount of Correction box.
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4. Click on the OK button.

You return to the Calibration Document window.

5. Click on the Send & Print button.

The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.
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6. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.

7. View the calibration test print and determine which cluster appears
the most neutral.

If the Visual Gray Balance most-neutral cluster number on the 
test print ends in 25, the printer is already calibrated. You should 
now perform a Visual Linearity calibration.

If the Visual Gray Balance number on the test print does not 
end in 25, you must recalibrate the printer to the most neutral 
cluster number.

NOTE: If you enter a value that ends in 25, the calibration table does 
not change.

8. Click on the Input button.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MACINTOSH

2–29Part No. 1H9659   September 1997

The Input Test Print Values dialog box appears.

9. Type the number of the most-neutral cluster in the Cluster Number box.

10. Click on the Recompute the Table button.

The calibration table data is updated and the Calibration Document
window appears.
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11. Click on the Send  button if you are satisfied with the neutral in the cluster 
you selected and you do not want to look at another calibration print.

A confirmation box appears.

12. Click on the Send button.

The recomputed table is sent to the printer and the following 
message appears.

13. Click on the OK button.

The calibration table is computed using the specified values and you
return to the Calibration Document window. You should now perform a
Visual Linearity calibration.

NOTE: You should make another test print to verify your input 
value adjustments.
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Visual Linearity

Visual Linearity calibrates your printer so it produces the correct shading
(lightness/darkness).

Use the Linearity Reference Card to select a cluster for each of the six
density ranges. Visual Linearity calibration prints look similar to the
following examples.

CMYKCMY K

Using the Linearity Reference Card

The Linearity Reference Card is included with the Calibration Utility. 
Use this Reference Card for performing Visual Linearity calibrations.
Following are instructions for using the Reference Card.

1. Lay the Linearity Reference Card with the name at the top on the first
row of the calibration print.

NOTE: It may not be possible to find a cluster in which all six gray levels
exactly match the Linearity Reference Card. Select the cluster
that appears to be the closest match.

2. Slide the Linearity Reference Card across each patch in the row 
and determine which of the nine patches in the row most closely
matches the darkness on the Reference Card.

NOTE: Match the darkness on the Reference Card, not the color.

3. Repeat step 2 for each row on the calibration print.

Download from Www.Somanuals.com. All Manuals Search And Download.



Calibration Utility for MACINTOSH

2–32 September 1997   Part No. 1H9659

Running a Visual Linearity Calibration

After you have run a calibration using the Visual Gray Balance option,
use the Visual Linearity option to recompute the current calibration 
table using values from the test print.

1. Pull down the Calibration menu and select Visual Linearity.

You return to the Calibration Document window.

2. Click on the Send & Print button.

The Send and Print dialog box opens.

NOTE: Your Send and Print dialog box may appear different, depending
on your printer export module.
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3. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.

4. Use the Linearity Reference Card to select a box number for each of
the six density ranges.

If all of the Visual Linearity numbers on the test print are box number 5, 
the printer is already calibrated. You can close the Calibration Utility.

If the Visual Linearity numbers on the test print are not all box number 5, 
you must recalibrate the printer. Go to step 5.

5. Click on the Input button.

The Input Test Print Values dialog box opens.
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6. Type in the values you select from the test print in the text boxes.

7. Click on the Recompute the Table button.

The calibration table is computed using the specified values and the
Calibration Document window appears.

8. Click on the Send button to send the table to the printer.
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Densitometer

A Densitometer calibration corrects the printer’s response based on the 
densitometer reading for selected patches. If you have a densitometer, you 
do not need to run Visual Gray Balance and Visual Linearity calibrations. 
You only have to run the Densitometer calibration.

Print a test print and read it with a densitometer. There are two kinds of
densitometer prints: process and separation. The kind of print you get
depends on your printer. Densitometer calibration prints look similar to
the following examples.

CMYK
Process Densitometer Prints

CMY K

example: from a Kodak XLS 8600 Printer or Kodak Digital Science� 8650 Printer

Separations Densitometer Prints

example: from a Kodak Digital Science� DCP 9000 Printer

CMYKCMY K

NOTE: Separation prints have separate individual colors for each of the
cyan, magenta, and yellow planes. Process prints combine the
cyan, magenta, and yellow into a single gray column. Black is
always a separate column.

Using a densitometer, you enter the density results for each of the
patches in the Densitometer Input Test Print Values dialog box. In
each case, you always input the visual component for the patch.

For separations prints, enter the “C” component for the cyan
patches, the “M” component for the magenta patches, and the 
“Y” component for the yellow patches.

For process prints, enter the “C,”  “M,” and “Y” components for
each of the CMY patches.
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Running a Densitometer Calibration

If you have a densitometer, you can run the Densitometer calibration
instead of the Visual Gray Balance and Visual Linearity calibrations.

1. Set up your densitometer.

2. Pull down the Calibration menu and select Densitometer.

3. Pull down the Calibration menu and select Setup Densitometer....

The Calibration Setup – Densitometer dialog box appears.

4. Select a densitometer status in the Densitometer box.

5. Pull down the Number of Squares menu in the Test Print box and
select the number of squares in your test print.

6. Click on the OK button.
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You return to the Calibration Document window.

7. Click on the Send & Print button.

The Send and Print dialog box appears.

NOTE: Your Send and Print dialog box may appear different, depending
on your export module.
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8. Click on the Print button.

You return to the Calibration Document window. The calibration test
print is printed on the specified printer.

9. Click on the Input button.

The Input Test Print Values dialog box appears.
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One, three, or four Density Value columns appear in the Input Test
Print Values dialog box, depending on the calibration your printer
requires (for black ribbon, three-color ribbon, or four-color ribbon).

The number of Density Value rows is determined by the selection in
the Number of Squares menu (15 or 38).

Valid characters in this dialog box include numbers from 0 to 9, 
periods (.), and commas (,). The valid range is 0 to 3.999 (0 to 3,999). 
Move from cell to cell using your keyboard’s arrow keys. You can 
copy and paste any group of contiguous fields in a rectangular pattern.

10. Type the test print values in the text boxes.

NOTE: You can import densitometer data automatically with an 
import module. If your densitometer has an associated import
module, the densitometer readings will be imported directly into
the dialog box. Using the Kodak File Reader, you can read in 
a file of data and specify the end of Field and End of Record
characters. For more information, refer to “Import” on 
page 2–40.

11. Click on the Recompute the Table button.

The calibration table is computed using the specified values and the
Calibration Document window appears.
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Import

The selected import module opens a dialog box when you click on the
Import button in the Densitometer — Input Test Print Values dialog box.
For the Kodak File Reader, the following dialog box appears when you
click on the Import button.

End of Field Character —specify the end-of-field character used in 
your densitometer file: “space,” “comma,” “tab,” “CR” (carriage return),
“CR-LF” (carriage return/line feed), “LF” (line feed), and “Semi-colon.”

End of Record Character —specify the end-of-record character used in
your densitometer file: “space,” “comma,” “tab,” “CR” (carriage return),
“CR-LF” (carriage return/line feed), “LF” (line feed), and “Semi-colon.”

Open—the Open button allows you to find and import the densitometer 
file with the values you want to use in the Input Test Print Values dialog box.
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Option Descriptions
This section describes the Calibration Utility menu and dialog box options.

File Menu
This section describes the options on the File pulldown menu.

New—accesses the Calibration Document window so you can select
options for the current printer setup.

Open—accesses a file selection dialog box so you can select an existing
calibration table from which to start.

Close —closes the current calibration document.

Save—saves changes to the current calibration document. When you 
name a calibration document, you may want to include characters that 
indicate the selected media types. Saving a document this way allows you 
to select it later to use as a starting point for a new calibration document.

Save As... —accesses a dialog box in which you can specify a new 
name and location for the current calibration settings. When you name a
calibration document, you may want to include characters that indicate
the selected media types. Naming a document this way allows you to
select it later to use as a starting point for a calibration document.

Revert —returns a calibration document to its original state. All
recomputations are discarded.

Preferences... —accesses a dialog box that allows you to specify the
folder containing the export module and the folder containing the import
module (used for densitometer settings).

Quit —exits the Calibration Utility.
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Edit Menu
The Edit menu is enabled only when the Calibration Document window 
is open.

The options in the Edit menu are enabled only when you enter text in the
Printer Description and Media Description boxes.

Calibration Menu
The Calibration menu is enabled when the Calibration Document window
is open. You can choose to calibrate based on your input to the Visual
Gray Balance, Visual Linearity, and Densitometer dialog boxes.

Calibration Setup — Visual Gray Balance

This dialog box allows you to specify the degree of correction to apply
with the current calibration table.

NOTE: If you are using black-only media, you cannot use the Visual Gray
Balance calibration method to calibrate your printer.
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Amount of Correction

The Amount of Correction buttons allow you to specify the degree of
difference between neutrals the calibration print will present.

Fine—the calibration print offers the least degree of difference in neutrals
between the cluster in the upper left corner and the cluster in the lower
right corner. The cluster in the upper left corner is only slightly green and
the cluster in the lower right corner is only slightly magenta.

Select “Fine” to get the smallest hue range. This means that the hue
differences between clusters is small so you can fine-tune by choosing
between very similar neutrals.

Normal —the calibration print offers a moderate degree of difference in
neutrals between the cluster in the upper left corner and the cluster in the
lower right corner. The cluster in the upper left corner is somewhat green
and the cluster in the lower right corner is somewhat magenta.

Select “Normal” to get a larger hue range than “Fine.” This means that
the hue differences between clusters is slightly larger and adjacent
clusters are less similar.

Coarse —the calibration print offers the greatest degree of difference in
neutrals between the cluster in the upper left corner and the cluster in the
lower right corner. The cluster in the upper left corner is distinctly green
and the cluster in the lower right corner is distinctly magenta.

Select “Coarse” to get the largest hue range. This means that the hue
differences between clusters is easily discernible and adjacent clusters
are distinctly different.

Calibration Setup — Visual Linearity

This setting allows you to specify values from a test print to recompute
the current calibration table.
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Calibration Setup — Densitometer

This dialog box allows you to use values from a densitometer text table
to recompute the calibration table.

NOTE: Make sure that your densitometer is calibrated before you try to
calibrate your printer with the densitometer values.

Densitometer

The Densitometer radio buttons allow you to specify what type of density
data (Status A or Status T) your densitometer provides. The Calibration
Utility calculates the table data using the density type that the export
module needs for the current calibration slot.

NOTE: Depending on the export module and settings, one of these
options may not be available. For example, Status A is not
available for the Kodak Digital Science� DCP 9000 Printer.

Test Print — Number of Squares

The Number of Squares menu in the Test Print box allows you to specify
the number of squares (15 or 38) in your test print.
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Printer Menu
The Printer menu allows you to select a printer or set up the printer 
from the menu bar.

Select Printer —a menu with the printer selections for your 
system appears.

Printer Setup... —the Printer Setup for Calibration dialog box 
appears so you can make changes for the selected printer.

Easy-Cal Menu
The Easy-Cal menu allows you to start the Easy Cal calibration
procedure from the menu bar.

Begin... —the Easy Cal calibration procedure starts up.

Begin with Previous Settings... —the Easy Cal Step 4 dialog 
box appears.

NOTE: The Easy Cal calibration procedure cannot be used to calibrate 
a printer that is using black-only ribbon.
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Calibration Table Dialog Box
Pull down the File menu and select New to access a dialog box that
allows you to create a new calibration table.

Printer Setup

The Printer Setup box lists information about the ribbon and paper type
for which the printer will be calibrated. Click on the Change Setup button
to change the information that appears.

Change Setup —accesses the Printer Setup for Calibration dialog 
box so you can select options that match the media in the printer 
you are calibrating.
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Starting Point

The Starting Point box allows you to select the data that will act as a
base for the new calibration table.

Read Current Table From Printer —allows you to retrieve and begin
with the printer’s current table. Once the table is loaded, you can edit 
it and recalibrate the printer. This option is not always available as a
starting point.

Use Printer’s Default Table —default printer data acts as the starting
point for the new calibration document.

Copy Table from File —the calibration table you select with the Select
File button acts as the starting point for the new calibration document.

Select File —opens a selection box so you can choose an existing
calibration document from which to start.

OK

The OK button closes the dialog box and opens the Calibration
Document window. Refer to “Calibration Document Window” 
on page 1–48 for more information.

Cancel

The Cancel button closes the dialog box without creating a new
calibration document.
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Calibration Document Window
The Calibration Document window allows you to specify information
about the calibration table.

Printer Setup Information

The Printer Setup Information box lists information about the printer type,
ribbon, and paper type for which the printer will be calibrated.

Printer Description

The Printer Description text box allows you to enter information that
describes the printer for which the calibration table will be used. The text
you enter is used to help describe the specifics of a particular calibration
table. This text is not printed on the test print. An entry is optional. 
Use the Edit menu when you enter text.
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Media Description

The Media Description text box allows you to enter information that
describes the media for which the calibration table will be used. The text
you enter is used to help describe the specifics of a particular calibration
table. This text is not printed on the test print. An entry is optional. Use
the Edit menu when you enter text.

Calibration Tools

Calibration Tools offers handling options for the calibration table.

Send & Print —sends the current calibration table to the printer. 
A calibration print is generated so you can evaluate the results.

Input —accesses the Input Test Print Values dialog boxes so you can
enter Visual Gray Balance, Visual Linearity, and Densitometer data.

Send—sends the current calibration table to the printer without
generating a calibration print. This button is usually used after you 
have created a test print and have recomputed the calibration table.
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Appendix A Kodak XLS 8600 and 
Kodak DS 8650 Printers

Ribbon Media Choices
Kodak is introducing new thermal three-color (CMY) media ribbons
(V1.5) which are improved versions of the V1.0 three-color (CMY) 
ribbons. These changes affect only KODAK EKTATHERM XLS
Three-Color Ribbon products.

The Printer Setup for Calibration dialog box in the Calibration Utility 
allows you to select a media file in the Media File option. You must 
specify the media file that relates to the printer ribbon that your 
printer uses.

Check the tables on the following pages to determine which printer
ribbon version (V1.0 or V1.5) your printer is using. Select the
corresponding media file in the Printer Setup for Calibration 
Media File option when you use the Calibration Utility.

If you switch from the V1.0 ribbon to the new V1.5 ribbon, you must
download new calibration tables to your printer. To do this, use the
installation procedure “Using the Calibration Utility to Download 
Default Calibration Tables” on page A–4. Alternately, a specially
designed downloader can be obtained from one of these sources:

� Kodak’s World Wide Web site

http://www.kodak.com/digital �maging/digital �maging.shtml  
(Select Dye SubPrinters/Media/V1.5)

� Your Kodak dealer

� Your regional Kodak technical support
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Printer Ribbons (V1.0)

Product Name Catalog Number Product Code

KODAK EKTATHERM XLS
Three-Color Ribbon
/XTRALIFE Media

873–3925 5305

KODAK EKTATHERM XLS
Oversize Three-Color Ribbon
/XTRALIFE Media/CMY

162–7298 6304

KODAK EKTATHERM XLS
Oversize Three-Color Ribbon
/CMY

871–5963 7304

KODAK EKTATHERM XLS
Three-Color Ribbon
/CMY

887–3945 2336

Kodak XLS 8600 Media Files for V1.0

Windows 8600V100.RTB

Macintosh Kodak XLS 8600 Media V100

Kodak DS 8650 Media Files for V1.0

Windows 8650V100.RTB

Macintosh Kodak DS 8650 Media V100
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Printer Ribbons (V1.5)

Product Name Catalog Number Product Code

KODAK EKTATHERM XLS
Three-Color Ribbon
/XTRALIFE Media V1.5

807–6135 5306

KODAK EKTATHERM XLS
Oversize Three-Color Ribbon
/XTRALIFE Media V1.5

801–3716 8304

KODAK EKTATHERM XLS
Oversize Three-Color Ribbon
/CMY V1.5

821–4082 7305

KODAK EKTATHERM XLS
Three-Color Ribbon
/CMY V1.5

163–0474 4336

Kodak XLS 8600 Media Files for V1.5

Windows 8600V150.RTB

Macintosh Kodak XLS 8600 Media V100

Kodak DS 8650 Media Files for V1.5

Windows 8650V150.RTB

Macintosh Kodak DS 8650 Media V100
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Using the Calibration Utility to Download 
Default Calibration Tables
Check the tables on the previous pages to determine your printer ribbon
version (V1.0 or V1.5). If your printer ribbon version does not match 
the calibration tables in your printer, you must download the correct
calibration tables.

Putting Your Printer in Raster Mode

Use the printer front panel to place printer into Raster Mode for
Calibration. After calibration is complete, this procedure may 
be used to place the printer in PostScript Mode for PostScript�
language printing.

1. Press the Setup/Select button to enter Setup Mode.

2. Press the Cancel (Scroll down) button until “Mode” appears.

3. Press the Setup/Select button.

4. Press the Cancel (Scroll down) button until the desired Print Mode
(“Raster” or “PostScript”) appears.

5. Press the Setup/Select button.

An asterisk appears next to the desired Print Mode.

6. Press the Cancel (Scroll down) button until “Exit” appears.

7. Press the Setup/Select button to select “Exit.”

8. Press the Cancel (Scroll down) button until “Exit” appears.

9. Press the Setup/Select button to select “Exit.”

The message “Please Wait” appears for a minute or so while the
printer initializes in the selected mode.

When the printer is initialized, the Print Mode, Donor Type, and Receiver
Type are displayed.
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Calibrating Your Printer for V1.5 Ribbon

Follow these steps to calibrate your printer for V1.5 printer ribbon.

1. Put your printer in Raster Mode via the printer’s front panel.

NOTE: For instructions, refer to the previous section,“Putting Your Printer
in Raster Mode.”

2. Install the export module for your printer.

NOTE: For more information about installing the export module, refer to
the export module user’s guide.

3. Install the Kodak Digital Science� Calibration Utility on your 
particular system.

� On a system running Windows:

– Pull down the File menu and select Run.

– Type a:\setup  <enter>.

NOTE: Replace “a” in the above command with the appropriate
drive letter, if necessary.

– Select printing and calibrating options.

� On a Macintosh system:

– Select and drag the Kodak DS Calibration Utility folder onto your
hard drive.

4. Start up the Calibration Utility.

5. Click on the Launch Normal Utility button in the Calibration 
Utility selection dialog.

6. Pull down the Printer menu and choose Select Printer.

7. Select SCSI ID or Network.

8. Pull down the File menu and select New.

The message “Create a new calibration table with these 
settings?” appears.

9. Select the Change Setup button.
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The Printer Setup for Calibration dialog box appears.

IMPORTANT: The following list of media type conditions must be 
updated for the new V1.5 ribbon media. Make each 
update from the Printer Setup for Calibration dialog 
box in the following order:

1. Reflective with XtraLife
2. Reflective without XtraLife
3. Fast Transparency (Kodak DS 8650 only)
4. Transparency

10. Select “Three-Color (CMY)” on the Ribbon Type drop-down menu.

11. Select the media type on the Print Mode drop-down menu as
specified in the above IMPORTANT note.

12. Select or deselect the XtraLife check box in the Printer Setup for
Calibration dialog box as specified for the media type that you are
updating (refer to the above IMPORTANT note).

13. Click on the Select button (located to the right of Media File).

14. Specify a media file for your particular printer.

� Kodak XLS 8600

Windows 8600V150.RTB

Macintosh Kodak XLS 8600 Media V150

� Kodak DS 8650

Windows 8650V150.RTB

Macintosh Kodak DS 8650 Media V150

15. Click on the OK button.

16. Select the Use Printer’s Default Table button in the Starting Point box
in the Calibration Table dialog box.

17. Click on the OK button.

A Calibration Document window appears.

18. Click on the Send button.
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The calibration table is sent to printer.

19. Pull down the Printer menu and choose Printer Setup.

20. Repeat steps 9 through 12, step 15, and step 18 for each of the
media types listed in the IMPORTANT note on the previous page.

21. Exit the Calibration Utility.

Your printer is now calibrated for the new media.

Calibrating Your Printer for V1.0 Ribbon

To calibrate your printer for V1.0 printer ribbon, follow the instructions 
in “Calibrating Your Printer for V1.5 Ribbon,” but select the media file 
for V1.0 in step 14.

Remember to update all media type conditions:

� Kodak XLS 8600

Windows 8600V100.RTB

Macintosh Kodak XLS 8600 Media V100

� Kodak DS 8650

Windows 8650V100.RTB

Macintosh Kodak DS 8650 Media V100
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Do I Need to Calibrate My Printer?
In order for your thermal prints to have the correct color balance, the
printer ribbon must match the calibration tables contained in your printer.

� If your prints have a slight pinkish hue, you are using V1.5 printer
ribbon with V1.0 calibration tables.

� If your prints have a slight greenish hue, you are using a V1.0 printer
ribbon with V1.5 calibration tables.

Check the tables in this appendix to determine your printer ribbon 
version (V1.0 or V1.5). If your printer ribbon version does not match 
the calibration tables in your printer, you must download the correct
calibration tables.

If the calibration tables are correct and you would like to improve the
color balance, refer to the section entitled “Operating the Calibration
Utility” for your particular computer platform in this manual.
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Index
A
Amount of Correction, 1–47, 2–43

Coarse, 1–30, 1–47, 2–26, 2–43
Fine, 1–30, 1–47, 2–26, 2–43
Normal, 1–30, 1–47, 2–26, 2–43

B
Begin, 1–49, 2–45
Begin with Previous Settings, 1–49, 2–45
Black-only ribbon, 1–6, 1–28, 2–4, 2–24

C
Calibrating printer, A–8

for V1.0 ribbon, A–7
for V1.5 ribbon, A–5 to A–7
using test print, 1–14 to 1–15, 2–12 to 2–13

Calibration
Densitometer, 1–39 to 1–44, 2–35 to 2–40

running, 1–40 to 1–43, 2–36 to 2–39
menu, option descriptions, 1–46 to 1–48, 2–42 to 2–44

Densitometer, 1–48, 2–44
Visual Gray Balance, 1–46 to 1–47, 2–42 to 2–43
Visual Linearity, 1–47, 2–43

table
creating new, 1–16, 2–14
opening, 1–16, 2–14
opening existing, 1–26 to 1–27, 2–23
saving, 1–15, 2–13

Visual Gray Balance, 1–29 to 1–34, 2–25 to 2–30
running, 1–30 to 1–34, 2–26 to 2–30

Visual Linearity, 1–35 to 1–38, 2–31 to 2–34
running, 1–36 to 1–38, 2–32 to 2–34
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Calibration document
creating new, 1–16, 1–19, 2–17
opening existing, 1–19, 2–17

table, 1–26 to 1–27, 2–23
selecting starting point, 1–20 to 1–25, 2–18 to 2–22
starting from previously created and saved, 1–16
starting point

using existing table, 1–23 to 1–25, 2–21 to 2–22
using printer’s current calibration table, 1–20 to 1–21, 

2–18 to 2–19
using printer’s default table, 1–22, 2–20

using existing table, 1–23 to 1–25, 2–21 to 2–22
using printer’s current calibration table, 1–20 to 1–21, 2–18 to 2–19
using printer’s default table, 1–22, 2–20

Calibration Document window
option descriptions, 1–52 to 1–53, 2–48 to 2–49
using, 1–28, 2–24

Calibration Table dialog box, option descriptions, 1–50 to 1–51, 
2–46 to 2–47

Calibration Tools, 1–53, 2–49
Cancel, 1–51, 2–47
Media Description, 1–53, 2–49
OK, 1–51, 2–47
Printer Description, 1–53, 2–48
Printer Setup, 1–50, 2–46
Printer Setup Information, 1–52, 2–48
Starting Point, 1–51, 2–47

Calibration Tools, 1–53, 2–49
Input, 1–53, 2–49
Send, 1–53, 2–49
Send & Print, 1–53, 2–49

Calibration Utility
for Macintosh systems, 2–1 to 2–49
for Microsoft Windows, 1–1 to 1–53

Cancel, 1–51, 2–47
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Change Setup, 1–50, 2–46
Close, 1–45, 2–41
Coarse Visual Gray Balance, 1–30, 1–47, 2–26
Configuration

minimum
Macintosh, 2–1
Windows, 1–1

recommended
Macintosh, 2–1
Windows, 1–1

Copy Table from File, 1–51, 2–47
Creating

new calibration document, 1–19, 2–17
new calibration table, 1–16, 2–14
test print, 1–12 to 1–13, 2–11 to 2–12

D
Default calibration tables

loading, A–4 to A–7
sending to printer, 1–12, 1–13, 2–11

Densitometer, 1–17, 1–48, 2–15, 2–44
calibration, 1–39 to 1–44, 2–35 to 2–40

running, 1–40 to 1–43, 2–36 to 2–39
Number of Squares, 1–48, 2–44
printer calibration

Macintosh, 2–35 to 2–40
Windows, 1–39 to 1–44

prints, 1–39, 2–35
status, 1–40, 2–36
Test Print, Number of Squares, 1–48, 2–44

Density values, 1–43, 2–39
importing, 1–43, 1–44, 2–39, 2–40

DS 8650 Printer, A–1 to A–8
ribbon media choices, A–1 to A–3

V1.0, A–2
V1.5, A–3
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E
Easy Cal

calibration procedure
Easy Cal Step 1, 1–7 to 1–8, 2–5 to 2–6
Easy Cal Step 2, 1–8 to 1–10, 2–7 to 2–8
Easy Cal Step 3, 1–10 to 1–12, 2–9 to 2–10
Easy Cal Step 4, 1–12 to 1–13, 2–11 to 2–12
Easy Cal Step 5, 1–14 to 1–15, 2–12 to 2–13
Macintosh systems, 2–4 to 2–13
Windows systems, 1–6 to 1–15

menu option descriptions, 1–49, 2–45
Begin, 1–49, 2–45
Begin with Previous Settings, 1–49, 2–45

starting up
Macintosh systems, 2–3
Windows 3.1x, 1–3
Windows 95, 1–5

Easy Cal Step 1, 1–7 to 1–8, 2–5 to 2–6
Easy Cal Step 2, 1–8 to 1–10, 2–7 to 2–8
Easy Cal Step 3, 1–10 to 1–12, 2–9 to 2–10
Easy Cal Step 4, 1–12 to 1–13, 2–11 to 2–12
Easy Cal Step 5, 1–14 to 1–15, 2–12 to 2–13
Edit menu option descriptions, 1–46, 2–42
Exit, 1–45
Export module, 1–17, 2–5, 2–15

locating files for, 1–9, 2–7
selecting, 1–3, 1–4, 1–7 to 1–8, 1–16, 2–5 to 2–6, 2–14

F
File menu option descriptions, 1–45, 2–41

Close, 1–45, 2–41
Exit, 1–45
New, 1–45, 2–41
Open, 1–45, 2–41
Preferences, 1–45, 2–41
Quit, 2–41
Revert, 1–45, 2–41
Save, 1–45
Save As, 1–45, 2–41

Fine Visual Gray Balance, 1–30, 1–47, 2–26
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I
Import, 1–44, 2–40

End of Field Character, 1–44, 2–40
End of Record Character, 1–44, 2–40
module, 1–17, 1–44, 2–15, 2–40

for densitometer settings, 1–17
Open, 1–44, 2–40

Input, 1–53, 2–49
Introduction, v

K
Kodak DS 8650 Printer, A–1 to A–8

ribbon media choices, A–1 to A–3
V1.0, A–2
V1.5, A–3

Kodak XLS 8600 Printer, A–1 to A–8
ribbon media choices, A–1 to A–3

V1.0, A–2
V1.5, A–3

L
Linearity Reference Card, using, 1–35, 1–38, 2–31, 2–33

M

Macintosh system
starting Calibration Utility on, 2–3

Media, selecting, 1–10 to 1–12, 2–9 to 2–10
in Printer Setup for Calibration dialog box, 1–18, 2–16

Media Description, 1–53, 2–49
Most neutral cluster, 1–32, 2–28
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N
Neutral gray, choosing, 1–14, 1–29, 2–12, 2–25
New, 1–45, 2–41
New calibration table, creating, 1–16, 2–14
Normal Utility, starting up

Macintosh systems, 2–3
Windows 3.1x, 1–3
Windows 95, 1–5

Normal Utility calibration procedure
Macintosh systems, 2–14 to 2–40

printer calibration, 2–25 to 2–40
Windows systems, 1–16 to 1–44

printer calibration, 1–29 to 1–44
Normal Visual Gray Balance, 1–30, 1–47, 2–26
Number of Squares, 1–48, 2–44

O
OK, 1–51, 2–47
Open, 1–45, 2–41
Opening

existing calibration document, 1–19, 2–17
existing calibration table, 1–16, 2–14

Operating Calibration Utility
Macintosh systems, 2–3 to 2–40
using Easy Cal

Easy Cal Step 1, 1–7 to 1–8, 2–5 to 2–6
Easy Cal Step 2, 1–8 to 1–10, 2–7 to 2–8
Easy Cal Step 3, 1–10 to 1–12, 2–9 to 2–10
Easy Cal Step 4, 1–12 to 1–13, 2–11 to 2–12
Easy Cal Step 5, 1–14 to 1–15, 2–12 to 2–13
Macintosh systems, 2–4 to 2–13
Windows systems, 1–6 to 1–15

using Normal Utility
Macintosh systems, 2–14 to 2–40
Windows systems, 1–16 to 1–44

Windows systems, 1–3 to 1–44
Option descriptions, 1–45 to 1–53, 2–41 to 2–49
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P
Preferences, 1–45, 2–41

setting, 1–17, 2–15
Printer

media, selecting, 1–10 to 1–12, 2–9 to 2–10
menu option descriptions, 1–49, 2–45

Printer Setup, 1–49, 2–45
Select Printer, 1–49, 2–45

model, selecting, 1–7 to 1–10, 2–5 to 2–6, 2–7 to 2–8
selecting, 1–18, 2–16
setting up, 1–18, 2–16

Printer calibration, 1–29 to 1–44, 2–25 to 2–40
Densitometer

Macintosh, 2–35 to 2–40
Windows, 1–39 to 1–44

Visual Gray Balance
Macintosh, 2–25 to 2–30
Windows, 1–29 to 1–34

Visual Linearity
Macintosh, 2–31 to 2–34
Windows, 1–35 to 1–38

Printer Description, 1–53, 2–48
Printer Setup, 1–49, 1–50, 2–45, 2–46

Change Setup, 1–50, 2–46
Printer Setup for Calibration dialog box, 1–18, 2–16
Printer Setup Information, 1–52, 2–48
Printing test print, 1–12 to 1–13, 2–11 to 2–12

Q
Quit, 2–41

R
Raster Mode, putting printer in, A–4
Read Current Table From Printer, 1–51, 2–47
Reference Card, 1–35
Revert, 1–45, 2–41
Ribbon media choices, A–1 to A–3

V1.0, A–2
V1.5, A–3
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S
Save, 1–45
Save As, 1–45, 2–41
Saving calibration tables, 1–15, 2–13
Select File, 1–51, 2–47
Select Printer, 1–49, 2–45
Selecting

export module, 1–7 to 1–8, 2–5 to 2–6
printer, 1–18, 2–16

media, 1–10 to 1–12, 2–9 to 2–10
model, 1–7 to 1–10, 2–5 to 2–6, 2–7 to 2–8

Send, 1–53, 2–49
Send & Print, 1–53, 2–49
Setting preferences, 1–17, 2–15
Starting Calibration Utility

in Windows 3.1x, 1–3 to 1–4
in Windows 95, 1–4 to 1–5
on Macintosh system, 2–3

Starting Point, 1–51, 2–47
Copy Table from File, 1–51, 2–47
Read Current Table From Printer, 1–51, 2–47
Select File, 1–51, 2–47
Use Printer’s Default Table, 1–51, 2–47

System configuration
minimum

Macintosh, 2–1
Windows, 1–1

recommended
Macintosh, 2–1
Windows, 1–1

System requirements
Macintosh, 2–1
Windows, 1–1

T
Test print

creating, 1–12 to 1–13, 2–11 to 2–12
using to calibrate printer, 1–14 to 1–15, 2–12 to 2–13
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U
Use Printer’s Default Table, 1–51, 2–47
Using Calibration Document window, 1–28, 2–24

V
Visual Gray Balance, 1–46 to 1–47, 2–42 to 2–43

Amount of Correction, 1–47, 2–43
Coarse, 1–30, 1–47, 2–26, 2–43
Fine, 1–30, 1–47, 2–26, 2–43
Normal, 1–30, 1–47, 2–26, 2–43

calibration, 1–6, 1–29 to 1–34, 2–4, 2–25 to 2–30
running, 1–30 to 1–34, 2–26 to 2–30

printer calibration
Macintosh, 2–25 to 2–30
Windows, 1–29 to 1–34

Visual Linearity, 1–47, 2–43
calibration, 1–35 to 1–38, 2–31 to 2–34

running, 1–36 to 1–38, 2–32 to 2–34
printer calibration

Macintosh, 2–31 to 2–34
Windows, 1–35 to 1–38

W
Windows 3.1x

starting Calibration Utility in, 1–3 to 1–4

Windows 95
starting Calibration Utility in, 1–4 to 1–5

X
XLS 8600 Printer, A–1 to A–8

ribbon media choices, A–1 to A–3
V1.0, A–2
V1.5, A–3
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